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What is Workshare Compare

Workshare Compare reimagines multi-party review and collaboration and ensures the safe 
and accurate exchange of information, enabling the collaborative evolution of high value 
business documents. 

Workshare Compare is a desktop application that automates managing changes to 
business documents.

Key features of Workshare Compare include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Compare can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications.



Workshare Compare 10.3 Release Notes

4

What’s New in Workshare Compare 10.3

The Professional 10.3 release includes the following:

 Rendering sets in Compare for Excel

Rendering sets affect what changes are detected as well as how changes are 
displayed. Compare for Excel includes two default rendering sets or you may 
create your own.

A rendering set is selected before running a comparison. A different rendering set 
can also be applied after the comparison has been run and new rendering sets 
created using options in the Compare for Excel ribbon.
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 Access to Workshare’s comparison functionality from the Litera ribbon

If configured, the Compare and Selective Compare options (Compare group) are 
added to the Litera ribbon in Microsoft Office (Word, Excel, PowerPoint and 
Outlook). Users can then launch Workshare’s comparison functionality from the 
Litera toolbar.

This is configured using the Add the Workshare Compare group to the Litera 
Desktop ribbon in Microsoft Office parameter in the General > User Interface
category in the Workshare Configuration Manager.

 Assorted bug fixes

System Requirements

The recommended system requirements for Workshare Compare 10.3 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare Compare 10.3 has a 32-bit version for 32-bit Microsoft Office environments and 
a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Compare 10.3
(32-bit version)

Workshare Compare 10.3 (32-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

mailto:support@workshare.com
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Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop)

 Microsoft Office 2019 (32 bit) – including click-to-run

 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Compare 10.3
(64-bit version)

Workshare Compare 10.3 (64-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
mailto:support@workshare.com
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Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs – Workshare Compare is unable to compare secure PDFs or convert secure 
PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Compare does not support Outlook when it is configured with a 
POP or IMAP account.

Important installation information

 Workshare Compare installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Compare if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
https://www.microsoft.com/en-us/download/details.aspx?id=25
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 Windows 7: When UAC is set to Default, running the Workshare Compare install 
displays the UAC prompt. You must approve the prompt and Workshare Compare
will be installed. Running the Workshare Compare MSI silently will fail when UAC is 
set to Default because the user is not given the opportunity to approve the UAC 
prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Compare, we strongly 
recommend that you first uninstall them before installing Workshare Compare 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

Ref CR Description

PRO-3239 01167599 iManage test connection fails in WCM (Admin Mode)

PRO-3690 Save as' dialog doesn't appear in focus when saving 
PowerPoint Comparison to the server from 'Create' button

PRO-3711 01040245 Compare for PPT - Workshare PDF Publisher is always 
listed as default in Print Comparison Report dialog

PRO-3751 01152714 Default print size changes to 'Legal' for documents that use 
a section break to switch to 'Landscape' layout

PRO-3765 Compare for Excel - changes made in the exported file are 
not reflected in the document and also the version is not 
updated when user relaunches the document from 
NetDocuments.

PRO-3787 WCM Admin option is show as modified at start, when no 
options have been modified

PRO-3790 Changes made in the exported file are not reflected to the 
document and also the version is not updated when user 
relaunches the document from iManage

PRO-3804 01171909 Workshare crashing when comparing certain Excel files

PRO-3863 Failed to run 'Convert to Track Changes' error dialog is 
displayed when switching modes of the comparison.

PRO-3918 File extension is appended to resultant redline (Word) 
document name when comparing supported documents.

PRO-3919 Help application is not launched when user clicks on 'Help' 
button from the Compare for Excel ribbon.

PRO-3949 Output Filename' dialog is displayed when user performs 
print action and then cancels the print action from the Print 
dialog for the second time.
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Ref CR Description

PRO-4056 01173864 Compare does not retrieve the latest saved version of a 
document when comparing files from iManage Work 10 
using the MRU list.

PRO-4119 Modified document view in TER is displayed distorted 
when saving/Printing as PDF and swapping the 
documents.

PRO-4165 Export' button is not functional on comparison window, 
when comparing certain Excel documents.

PRO-4181 When performing 'Attach/relate to Original (or) Modified' 
action, no document is displayed under Related 
documents tab.

PRO-4238 Error dialog, "the Comparison couldn't be performed' You 
could try re-saving..." is displayed, when comparing certain 
Excel files with deleted 'Overlaid Objects'.

PRO-4256 01175276 Documents remains checked-out when saving a 
comparison as attached/related to the Original/Modified 
document in Work 10 (.docx only)

PRO-4291 No documents is displayed under Related documents tab 
when performing Attach/Relate to the Original/Modified 
Presentation action from PowerPoint.

PRO-621 01120989 Selecting convert to PDF for the 'Save as related 
document' option titles the file with the Doc ID instead of 
file name.

Known Issues

The following are known issues in the Workshare Compare 10.3 release - for more 
information, please contact Customer Support.

Ref Description

PRO-4466

01176343

Compare for Excel: Documents using Simplified Chinese have redlines 
incorrectly showing as all modified or deleted.

PRO-4250

01174274

Compare only populates the modified field with an Appdata file path when 
selecting the 'Save and Sync' option from the iManage tab in Word.

PRO-4049

01173819

A .NET framework error occurs when launching Outlook if Workshare 
Compare is not licensed.

PRO-3843

01171983

Document specific: Specific Word documents are taking 3-5 minutes to 
compare.
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Ref Description

PRO-3753

01170892

Unable to select certain cells after running Excel comparison.

PRO-3709

01169986

Document specific: Compare for Excel hangs when comparing specific 
spreadsheets.

PRO-3689

01172368

When Nuance PDF is the default printer, a 0kb file is generated when 
printing a redline from Workshare Compare.

PRO-3449

01168494

The error "System.Threading.ThreadAbortException" may be displayed 
when saving a redline as attach/relate to original/modified document in 
OpenText DM 16.5.

PRO-3409

01168025

iManage integration: After an upgrade, the recent files list in Compare’s 
Document Selection dialog retains the recent files compared prior to the 
upgrade. However, you are not able to compare those recent iManage files 
because the path is shown as “interwovenSite://…” rather than 
“iManage://…”.

PRO-2812

01164429

Document specific: Compare for Excel hangs when comparing a specific 
sheet in a workbook.

PRO-2513
Errors can occur when using Selective Compare if Compare dialogs are 
open and the "Launch new comparison in running instance" configuration 
option is enabled.

PRO-1387
Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row 
is empty.

PRO-1386
Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019
Compare for Excel: Focus is not completely applied to the last change in 
the comparison window if the user clicks the Last Change button for the
first time.

PRO-837

01061816

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned.

PRO-792

01088791

After running a comparison in Workshare Compare, some line numbering 
and table text and row cells maybe be missing.

PRO-109

01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.



Workshare Compare 10.3 Release Notes

13

Ref Description

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds 
of the array' error is displayed.

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574
A user is not automatically logged into Compare after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the 
incorrect comparison theme is highlighted under the Select dropdown in 
the Home ribbon.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy 
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated 
help from time to time. The authors would like to assure users of their continued best efforts in supplying the most 
effective help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare Compare 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Compare 10.1: 27/3/19
Revised for Workshare Compare 10.1 Revision 1: 16/5/19
Revised for Workshare Compare 10.2: 28/6/19
Revised for Workshare Compare 10.2 Revision 1: 19/8/19
Revised for Workshare Compare 10.3: 2/10/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
http://www.workshare.com/
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